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1 LDSWin System Design

The LDSWin PC Software provides highly convenient screen-supported access to all operating data, operating
parameters and settings for local and remote LDS stores (e.g. for the configuration of LDS components, chang­
ing and correcting setpoints, defrost timers, etc.).

Running LDSWin on a host computer allows remote operation and remote maintenance of all stations in LDS
stores via modem link or network link. The fault report reception function also allows of monitoring any number of
LDS stores.

LDSWin supports various authorization levels:

� Demo version

� with setpoint change or

� without setpoint change

� Dongle with special rights for BMS stores (Building Services Management System)  - see section 12

Different authorization levels are assigned by dongle. Changes can only be made on an LDS store when a don­
gle with setpoint adjustment permission is connected, see Section 3.1 - Software Authorization Levels for de­
tails.

LDSWin store layout

The following operating systems are supported (see Section 2 - Installation for details):

‐ Windows 2000, Windows XP, Vista and Windows 7
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The following options are available for connecting LDSWin to a store:

� ISDN modem or analog modem (with ISDN connections an a/b converter is required)

� RS232 interface for direct connection to the CI 3000 Store Computer via null modem cable

� CAN bus PC adapter for connection to any point of the CAN bus installed in the store

� Network (LAN-Gateway)

LDSWin contains the following functions:

� Access security by dongle and password

� Graphical store layout with colored status display
- of refrigeration systems, refrigerated display cases and cold rooms
- Integrated building automation (if available)
  (e.g. heat recovery, control schemes for a range of different maintenance groups, heating etc.)

� Controller specific screens for setpoints
- Defining setpoints, configuration parameters and settings 
- Factory default settings and user-defined basic settings 
- Printing settings/setpoints as transfer protocol

� Actual values and data from the archive
- List output for processing in MS Excel/text format
- Display and printout of charts and tables of refrigeration, energy and operating data 
- Automatic services, e.g. HACCP/24-hour temperature lists/24-hour channel list

� Monitoring functions 
- Cyclic check of CI 3000 Store Computer and communication connection (modem/network)
- Store monitoring by fault report reception

� Store archiving

� Backup/restore functions for set parameters of complete stores of selected areas

� Data base functions for operation data

� Alarm forwarding by SMS, Email and FAX text messaging (see Section 6)

� Data exchange with CI 3000 Store Computer via serial port, modem, CAN bus PC adapter or network
(see Section 3.2 LDSWin Basic Settings)

� Multilingual. User languages available are: 
English, German, French (not full implemented Dutch, Czech, Finnish and Polish)

� Online help

Premium version functions (optional)

� Cross-store analysis, e.g. fault reports / activity / energy (see Section 13 - Premium Version Functions)
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1.1 Application of LDSWin

LDSWin can be employed as follows:

1. Offline parameter setting and analysis

For used by project designers and planners in preparing and processing stores (offline engineering)
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2. Integrated into the LDS system via the CI 3000 Store Computer

2.1 Remote operation as Host Computer

- (1) for fault report recording/alarming as well as for remote maintenance/diagnosis
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2.2 Local operation
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- (2) in machine room, e.g. for commissioning via the serial interface of the CI 3000

- (3) in store, e.g. in store manager's office via the CAN bus PC adapter
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3. Integrated into the LDS system as Service PC with CAN bus PC adapter without 
CI 3000 Store Computer

3.1 - Local operation in store, e.g. store manager's office or directly at refrigeration points/pack controllers

- Local operation for commissioning, e.g. in machine room or directly at the controller (siehe 3.2)
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3.2 Configuration and commissioning of stand-alone components

- The direct local parameter setting on UA 300 case/coldroom controller or
   VS 300 compact pack controller via TTY port on controller

- e.g. the store is commissioned of local components (see Section 11 - Parameter Setting Via TTY port).

-  For use by control panel or display case supplier in direct setting of basic parameters
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Z22

Z21

Z12

Z11

Z62

Z61

Z52

Z51

136

135

128

126

125

118

116

115

148

146

145

138

56

55

48

46

45

35

38

36

68

66

65

58

L

N

1414

1313

ADDRESS

CAN-BUS

D
IG

IT
A

L
2
3
0
 V

A
C

1

4

2

3

1

A41

A42

A51

A52

1

2

3

4

D31

D32

D41

D42

D12

D11

D21

D22

A12

A22

A32

A21

A11

A31

TTY

A
N

A
L

O
G

 I
N

 |
A

N
A

L
O

G
 O

U
TVS 300

Further details on the settings for the respective connection/link are contained in the 
chapter 4.2 Basic settings in LDSWin.
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2 Installing LDSWin

2.1 System requirements

The LDSWin software is supplied as installation CD. It is accompanied by a dongle for protection from unautho­
rized use of the software (see Section 2.3 Installing the Dongle). The dongle must always be connected to the
computer when starting and working with the program and is available in two versions, with or without setpoint
adjustment permission.

Minimum system requirements of the computer on which LDSWin is to be installed are as follows:

Computer type: Workstation or desktop PC, laptop or notebook computer

Processor: Intel Pentium 4 or compatible, 1 GHz or higher 
(depending on operating system)

RAM: min. 512 MB

Free space on hard disk: min. 500 MB

Operating system: Windows 2000 Service Pack 4 or higher
Windows XP Service Pack 2 or higher
Windows Vista
Windows 7

Screen resolution: min. 1024 x 768 pixels; 16-bit colors

Ports: 1 x USB port for USB dongle (Windows 2000 or newer version)
1 x Internal serial or USB modem
1 x RS232 port required for
     - Direct cable connection from PC to CI 3000 Store Computer or
     - Connection from PC via CAN bus PC adapter or
     - Direct cable connection from PC to UA 300 / VS 300 via TTY interface

A RS232 port must be installed on the computer if it does not already have one:
- Desktop/workstation  PC: PCI-COM port card
- Laptop/notebook computer: PCMCIA-COM port adapter

An USB-COM port adapter is not recommended!
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2.2 Installing the software

On computers running the Windows 2000 or XP, Vista and Windows 7 operating system, the user
must be authorized with administrator rights in order to install the software. The user must also be
assigned full read and write permission for the LDSWin folder in order to work with the program. 

The dongle is only to be attached following the installation of the software!

The computer on which the program is to be installed must meet the system requirements specified
in Section 2.1.

After starting the installer (by running Setup.exe from the CD, for example from Windows Explorer) and select­
ing the user language, the following window is displayed:

Click the Next button to display the following window containing important installation notes:

Carefully read and observe the installation notes!
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The next screen contains a dialog box, in which the required user data must be entered:

After entering the user data and clicking the Next button, the screen for the selection of the setup type (New in­
stallation/Update) appears:

LDSWin can be installed in different folders on the same computer to allow working with different
versions for example.

In addition to a New installation, the installation program provides the option of updating older versions of
LDSWin (Update). The following data from the older version is retained:

� All stores and the associate data (operating data, setpoint and actual value archives, store layouts)

� All forms

� All scripts

� All sets of parameters for pack controllers and case/coldroom controllers

� Passwords

� Program settings

� Fault report database
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In order for the earlier version to be updated correctly, the folder containing the earlier version must be specified
as the target path for installation.

A new folder must however be specified for new or separate installation of the program. If a new in­
stallation is carried out in a folder containing an existing version of LDSwin, all data form the original
installation will be lost, i.e. overwritten!

In the next screen, choose the folder in which the LDSWin software is to be installed. A new folder or one that
does not yet exist will be created automatically:

A separate program folder can be selected in the next screen:

Due to ongoing improvement of the LDSWin PC Software, the name of the program folder also
changes as well as the Version No. (e.g. 2.2.2.586).
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The following screen summarizes the choices you have made for installation:

Click on the Next button to start the actual installation of LDSWin.

The installation of the following components is carried out directly following the program installation
- the BDE database
- the driver for the hardware copy protection (dongle).

You must restart the computer after installation has completed:

After the computer has been rebooted, the dongle must be plugged into a USB socket in order for it to be recog­
nised by the system and configured before the first LDSWin program start (see chapter 2.3).
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2.3 Installing the dongle

The dongle is only to be attached following the installation of the software!, see section 2.2.

Proceed as follows to install the dongle:

� Connect the dongle to a USB port of the computer.

USB dongles are only supported by the Windows 2000 or a newer version of the Windows
operating system!

� Windows will automatically install the drivers for the new hardware found (i.e. the dongle). The drivers for the
dongle will be installed at the time of installing the LDSWin software.

If LDSWin is to be started automatically when the computer is switched on, the file 
LDSWin Startdelay.exe must be triggered by the Windows autostart. 
This file ensures that all the drivers required for the operation of LDSWin are already loaded and that
LDSWin starts without a problem.

2.4 Screen savers

You are urgently advised not to use a screen saver when operating LDSWin.

Screen savers utilize a large part of the computer's resources when activated. Reception of data telegrams (e.g.
when running scripts) also requires a certain minimum of resources. As a result, communication errors are not
to be ruled out when using screen savers.
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2.5 Screen fonts

For the correct display of the lettering within the LDS program, the setting Small Fonts, i.e. Normal Fonts must
be selected. Proceed as follows to do so:

1. Click Start, then Settings, then Control Panel.

2. Double-click the Display icon.

3. Depending on the operating system of your computer, select either the Settings or Appearance tab.

4. In the Font Size box select Small Fonts / Normal (XP)

Depending on the operating system used, the Font Size box will either be displayed direct or can be opened by
clicking the Advanced button.

2.6 Fault printout

Faulty printout is often due to incorrectly installed or defective printer drivers. If problems are encountered with
printing, you should first check whether the correct printer driver is installed and properly configured and
whether a newer printer driver may be available.

A minimum of one printer must be installed.
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2.7 Deinstalling the software / dongle driver

1. Open Windows Control Panel by clicking Start and Settings.

2. Double-click the Add/Remove Programs icon.

3. Select the entry LDSWin for Windows 2.2.

4. Click on the Remove button. This will remove LDSWin 2.2 from the computer.

Make sure the LDSWin program is not open when deinstalling it!

5. To deinstall the dongle driver, select Sentinel System Driver from the list and then click the 
Change/Remove button.

The Store folders are not deleted when deinstalling the program. They will not however be taken
over automatically on new installation of the software. It is advisable to move these Store folders to a
different folder, from where they can later be re-imported after re-installing LDSWin.
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3 Working with LDSWin and Starting the Program

The following pages describe how LDSWin works and the basic program settings.

3.1 Software authorization levels

LDSWin can run at different permission levels. The respective permission level is determined by the dongle
used. Available permission levels are:

� No dongle; the software runs in demonstration mode with strictly limited functions. The user cannot connect to
any store or the CI 3000 Store Computer, meaning that data cannot be sent or received. Several parameters
can neither be changed nor saved.

� Dongle without setpoint adjustment permission

This permission level allows only of updating data from the store. Data or settings cannot be transmitted to
the store and its components.

� Dongle with setpoint adjustment permission

Working with the software is not subject to any restrictions with this permission level.

� Dongle with special rights for BMS stores (Building Services Management System)  - see section 12

Incorrectly entered parameters (wrong setpoints, temperatures too high or too low, faulty device con­
figurations, etc.) may lead to serious damage at the stores or cause excessive operating costs!
Make sure that any new settings made are correct for the specific installation before transmitting
them to the equipment!

3.2 User permission levels

3.2.1 Launching LDSWin

To start LDSWin, click on the LDSWin program icon on your desktop or click Start, then Programs, then LDS for
Windows 2.2. The program's starting window is displayed and remains open until the program is fully initialized.
On completion of the starting phase, the log-in dialog opens automatically for the user to enter a password. A
password is required for user authentication.

3.2.2 Logging in

The log-in dialog authenticates the user. The required start passwords are supplied together with the dongle and
the LDSWin PC software.
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Following commissioning, the start passwords should be replaced with your own, new passwords via
the Change Password button.

In addition to entering the user password, the following options can also be activated in this screen:

� Dispatcher Attended

Defines whether the dispatcher (Service Center) is attended or not (see Section 7.2 Dispatcher)

� Easy Mode

For in-store use (store manager, trained store personnel): Screens are greatly simplified/reduced for ease of
use.

An error message will be displayed if the password entered is not valid or is typed incorrectly. Con­
firm the message by clicking OK and type in a valid password.

After correctly typing in a valid password, the assigned User Priority is displayed. Differentiation is made be­
tween the following User Priorities and associated functionalities.

� User Priority 0

Functionality of the program is restricted for users assigned this permission level. They are not able to change
any program settings. This includes creating and changing scripts, forms, stores, etc.

� User Priority 1

The full functionality of the program is available to users assigned this permission level.

The User Priority message must be confirmed by clicking OK.

Once the user has logged in successfully, the Select Store window opens automatically, listing all stores that
have been created to date.

To open an existing store, double-click the store wanted or click on the Open Store button (see Section 4.3
Opening a Store).

If only one store is installed, it will be opened directly after logging in.
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4 LDSWin Help, Basic Settings and Operation

This section describes the main steps for working with LDSWin.

4.1 Using LDSWin Help (F1 key)

Detailed information and assistance relating to program functions can be accessed through the Help function of
the LDSWin Software while working in any screen or part of the program.

LDSWin Help is a supplement to this User Guide.

The functionalities are described in the form of screen reference with topics grouped according to menu items.
When accessed by selecting the Help menu item or pressing the F1 key, Help opens with the list of contents:

Pressing the F1 key while a program window or screen is open accesses Help for the topic concerned. The In­
dex tab in the Help Topics window can be selected to search for items in the alphabetical index.
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Double-clicking on an index entry opens the respective Help page.

Further details on using Help will be found in the documentation supplied for your operating system
(Windows 2000, XP, Vista or Windows 7).

4.2 Basic settings in LDSWin

Basic settings, selection of operating mode and configuration of the LDSWin PC Software can be made by
choosing Settings from the File menu or by clicking the respective command button (see section 4.3.1).

4.2.1 General tab

Select the General tab to define the communication parameters for LDSWin. LDSWin can be linked to LDS
components via a range of different connections. Also see the diagrams in section 1.1 - Application of LDSWin.
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Connection via modem

LDSWin can be operated locally or remotely and is connected to the CI 3000 Store Computer via telephone line
using a modem.

1. Select computer link via Host computer (Modem).

A modem must be selected for this operating mode (see section 4.2.2 - Communication Tab)!

When using a modem connected to a PBX telephone system, it may be necessary to deactivate the
”Wait For Dial Tone” option in the modem settings.

2. Enter the following data in the appropriate Host Computer group:

- Service Center Phone No.: Number of telephone to which the modem of the PC 
  (on which LDSWin is installed) is connected.
- Extension: Must be activated when the modem is connected to a private branch exchange (PBX).

- External Dial prefix: Enter characters required to access an outside line.
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The following characters can be used:

Character Meaning (See documentation of the modem used for further details)

0 Dial out prefix

, Pause

& Generate flash signal

> Actuate earth key

- Internal Tel. No.: Internal telephone number of Host connection; only available when a 
  CI 3000 Store Computer can be accessed via an internal telephone number (private branch exchange)

- Country: Country prefix for the Host Computer (example 0049 for Germany).

- Without callback: 
  Unchecked: Dialed store calls back
  Checked: No callback from CI 3000 Store Computer when direct connection is activated, 

the connection to store continues.

Connection via direct link-up

LDSWin is designed for local use, a connection is established via:.

1. Operator PC (serial interface): With this configuration the PC is connected to the 
CI 3000 Store Computer direct via the serial port.

2. Operator PC (CAN Bus): With this setting the PC is connected to the store components via the CAN bus 
PC adapter. Requires specifying whether a CI 3000 Store Computer (SC) is installed.

3. Operator PC (UA 300 and VS 300 via TTY): This option allows direct parameter setting via the 
serial port on the PC and the TTY port on the UA 300 Case/Coldroom Controller or VS 300 Pack 
Controller (requires an optionally available special TTY adapter). Current actual values can also be 
displayed. When using this option, all setpoint parameters of the device connected can be 
displayed and changed.

This function is only available for UA 300 Case/Coldroom Controllers and VS 300 Pack Controllers
(see section 11 - Parameter Setting via TTY Port).
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Connection via network (LAN gateway)

LDSWin can be operated locally or remotely and is connected via network to those stores fitted with a LAN gate­
way.

4.2.2 Communication tab

Select the Communication tab to set the communication parameters for modem and send by E-Mail:
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Modem:

Select a modem type, e.g. MicroLink 56 i. Only modems that have been correctly installed under Modems in
Windows Control Panel can be selected. These modems are TAPI-controlled.

Only modems that have previously been installed on the PC can be selected (see modem operating
instructions!

E-Mail: The sender address and SMTP server must be specified if measurements are to be sent by e-mail using
scripts (see section 6 - Scripts in LDSWin). Further information can be obtained from your system administrator.

4.3 Opening a store

Once a user has logged in successfully, the Select Store window opens automatically, listing all stores that have
been created to date.

An existing store can be opened by double-clicking on the store or clicking the store command button.

During the opening of a BMS store, an additional password request for the BMS password is con­
ducted (see also chapter 12.5.7). If the password is not known the screen can be closed by pressing
the abort button, i.e. the ESC key, so that the ”classical” store view with the refrigeration components
is displayed. ).
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LDSWin then opens the store wanted and displays its layout showing the refrigeration points, pack controllers and
wireless sensors.

Clicking the Cancel button opens a blank window. A store can then be opened immediately or later
by clicking the Store - New Folder command.
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4.3.1 Buttons in store layout

Functions assigned to the buttons in LDSWin are as follows:

Button No. Action

1 Save data

2 Change LDSWin settings (see section 4.2 - LDSWin Basic Settings)

3 Dispatcher Attended/Unattended

4 Activates/deactivates script execution

5 Online

6 Offline

7 Select store

8 Store properties (see section 5 - Setting Up a LDSWin Store)

9 Show table - double-clicking1) a component displays evaluation for the component in tabular form.

10 Show chart - double-clicking1) a component displays evaluation for the component in chart form.

11 Show controller data - double-clicking a component displays the controller data for the component.

12 Show controller data in process diagram - double-clicking1) a component displays the controller data
for the component in schematic form.

13 Show controller data in Easy Mode - double-clicking1) a component shows the component in Easy
Mode.

14 Item names - the full text name of all components in the store layout is displayed as long as this button
is held clicked.

15 Show fault reports for currently open store. 
Fault reports for all stores can be viewed by choosing Fault Reports All Stores from the File menu.

16 Select color - Change color in store layout

17 24-hour temperature list

18 Print store layout

19 Help - Opens LDSWin Online Help. Related online help can be opened any time in any screen by
pressing the F1 key.

20 The symbol is only visible and flashing when setpoint changes have been made in the store. Detailed
information of where exactly changes have been made can be found under the menu items:
- Refrigeration Points/Channel Selection
- Refrigeration Systems/System Selection
- Radio Sensors/Radio Receiver
Important: Components effected by the changes are marked in red!

21 Activates/deactivates the change mode (used to alter the design of the store layout, i.e. position com­
ponents. Can also be activated/deactivated by pressing the F2 key).

1) Double-clicking will only open the screen when NO check mark is placed against Change Mode in the View file.
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4.4 Connecting to the CI 3000 Store Computer

Online connection to the currently selected store can be made by clicking the Online button or choosing the On­
line command from the File menu. The Connecting window is displayed while the store is being dialed up.

An error message will be displayed if connection fails. Click the Cancel button to close the window in
such an event.

After connecting successfully to the store, LDSWin automatically interrogates various store configuration data. A
message is displayed to the user if LDSWin detects any differences between the store configuration as stored in
memory and the actual configuration. The user must then decide whether or not to apply the data received.

As a general rule the store data should be applied first!
Exceptions: Offline parameterisation and firmware update of the store computer.

If the configuration is identical at both ends, the Connecting window closes and the user can commence working
online with the store. In order to close an existing connection to the store press the Offline button, i.e. disconnect
via the menu item File/Offline.

4.5 Viewing data for refrigeration points and pack controllers

The following items describe how to view the various data of refrigeration points and pack controllers and the
form in which the data is displayed.

Online connection to the store must have been made before data can be displayed. Command but­
tons for updating data are only active in online mode.

Archived data of a controller can be displayed in table or chart form. Current setpoints and actual values are dis­
played in the Setpoints and Controller Data screens. Data can be accessed in three ways:

1. Choose the form of display wanted from the View menu or menu buttons - double-click the icon of the con­
troller wanted.

2. Right-click the component wanted and choose the form of display wanted from the shortcut menu.

3. Choose the Select Channel command from the Refrigeration Points menu for refrigeration points or the Se­
lect System command from the Refrigeration Systems menu for pack controllers and right-click with the mouse
in the displayed selection of devices to open the shortcut menu and select the form of display wanted.
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4.5.1 Tables

A table is filled with the archive data for the selected controller and displayed. The channels shown can be up­
dated in online mode by clicking the Update button:

By clicking the respective command buttons, the tabulated data can be printed or saved to an MS Excel or text
file in *.XLS or *.TXT format respectively.

Archive data displayed in the table is defined by a form. The allocation of the form is carried out via
the device list, see chapter 5.1 Allocating forms to devices.
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4.5.2 Charts

A chart is filled with the archive data for the selected controller and displayed. The channels shown can be up­
dated in online mode by clicking the Update button:

By clicking the respective command buttons, the charted data can be printed or saved to file in *.BMP or *.JPG
format.

Arcvive data displayed in the chart is defined by a form.The allocation of the form is carried out via
the device list, see chapter 5.1 Allocating forms to devices. In order to display the data in a different
form, a user specific form can be selected via the selection screen ”Form”.

Right-clicking in the chart opens a shortcut menu, which can be used to activate or deactivate viewing of the
separate channels and to change color of the channels:

For further details of the separate functions refer to LDSWin Help (F1 key).
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4.5.3 Controller data

The controller data screen shows the most important setpoints and actual values for the selected controller.
Contents of the screen are updated automatically at set intervals (approx. 15 sec) while the communication link
is online.

See section 4.6 - Defining Setpoints for Refrigeration Points and Pack Controllers for more details of
changing and adjusting setpoints.

Press the Table or Chart button to change to the respective view of the archive data for the selected controller.

4.6 Setpoint adjustment of LDS components

Before changing setpoints, the setpoints should always be updated by clicking the Update button. This
will prevent overwriting setpoints on the controller by values that are incorrect or unwanted!

Screens for adjusting setpoints can be displayed in two ways:

� Right-click a component in the store layout to open a shortcut menu and choose the Setpoints option from this
menu.

� Choose the Select Channel command from the Refrigeration Points menu for refrigeration points or the Select
System command from the Refrigeration Systems menu for pack controllers or Wireless sensors - Receiver
Modules to open a list of devices. Right-click an entry in the open list of devices to open a shortcut menu and
choose the Setpoints option from this menu:

Online connection to the store must have been made before current data can be displayed. The Up­
date and Send buttons are only active in online mode.
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Setpoint screen for refrigeration points:

Setpoint screen for pack controllers:
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Setpoint screen for wireless sensors:

4.6.1 Working with setpoint screens

Values can be entered in the white fields of the Setpoints screen. If a value is dimmed (grey), it means that the
value shown cannot be changed. If an invalid value is entered, an error message will be displayed prompting
you to enter a valid value. Clicking on the command buttons at the bottom of the screen performs the following
actions:

Apply:

Applies the current settings.

Users assigned User Priority 0 or a dongle without setpoint adjustment permission cannot send set­
points to the controller. Refer to Help (press F1 key for further details).

Cancel:

Closes the screen and cancels all changes.

Update:

Updates setpoints in the screens.

Send:

Sends the setpoints as displayed to the controller concerned.

You must be connected online to the store for the current date to be displayed. The Update and
Send buttons are only active in online mode (otherwise they are dimmed).
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Table or Chart:

Changes display of archive data to table or chart form for the controller concerned (see section 4.5 - Viewing
Data for Refrigeration Points and Pack Controllers).

Parameter Sets:

Enables basic settings to be loaded (see section 4.6.2 - Parameter Sets).

Refer to the documentation for the respective case/coldroom controller or pack controller for details
of controller configuration.

4.6.2 Parameter sets

Sets of parameters can be created in the setpoint screens of case/coldroom controllers and pack controllers.
Click on the Parameter Sets button to open the Parameter Management screen:

Existing parameter sets can be viewed and selected in the selection list. Click on the command buttons at the
right side of the screen to perform the following actions:

Load:

Enters data from the selected sets of parameters in the screens of the case/coldroom controller or pack controller.

Save:

Saves setpoints currently entered in the controller's Setpoint screen (see section 4.6.1 - Working with Setpoint
Screens) in the selected parameter set. To create a new parameter set, type a new name in the entry field of the
selection list.

With controllers that have different version numbers for each controller type, the name of the con­
troller's parameter set should include the Version No. so as to avoid incompatibility between different
versions).

Delete:

Deletes the selected parameter set.
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Default:

Loads the default value of the respective controller (default configuration).

Cancel:

Closes the screen without accepting the changes made.

Each parameter set is valid for only one controller type. Parameter sets created for a given controller
type are exclusively available for that type.

With controller type UA 300 L, loading a parameter set exclusively changes the setpoints for the po­
sition (temperature sensor) currently shown on the Setpoints page. Setpoints for all other positions
and data on the Defrost Timer and Configuration pages are left unchanged!
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5 Setting Up Stores in LDSWin

This section contains examples for setting up new stores and modifying existing stores in the LDSWin software.

5.1 Creating a store

� Select the item New/Folder in the Store menu. Pressing the Add Store button opens a dialog box in which the
following data can be entered

Store Name:  Random name for the store. The name must be unique within the local folder and cannot be du­
plicated.

Store ID: The store ID is the identification authorizing access to the store. Online access to the store when it is
closed is only possible by entering the correct Store ID.

Country: Country code for store (e.g., D or 0049 for Germany)

Phone No.: Telephon number of the store.

Internal telephone number of store. Active when the CI 3000 Store Computer can be accessed by dialing an
internal telephone number.

IP address: IP address of the LAN gateway

Without callback: 
  Unchecked: Dialed store calls back
  Checked: No callback from CI 3000 Store Computer when direct connection is activated, 

the connection to store continues.

SC Check: Must be activated when Store Computer Check is to be made on the store (see also section 6.2 -
Store Computer Check).
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Archive On Fault: In fault conditions a script is generated for alarm archiving so as to permit automatic interro­
gation of certain actual value buffers of the refrigeration point. This also requires the Archive On Fault  check
box to be activated in the File / Settings / Fault Reports / Activated Functions menu.

The new store created is listed as an item in the LDS Win 2.2 folder. It can then be selected and opened by
clicking on the Open Store button or double-clicking the store.

5.2 Entering store properties

After opening a store, global settings for the store can be made in the store properties. These include, amongst oth­
ers, the communication parameter, alarm configuration and alarm structure for the dispatching of messages, de­
frost times and other entries. Choose Properties from the Store menu to open the Store Properties window:

Always update the setpoints by clicking the Update button before changing setpoints. This will en­
sure that setpoints on the controller are not overwritten by unwanted values!

Click on the Update button to load the existing configuration from the CI 3000 Store Computer into the program.

Current data can only be displayed while connected online to the store. The Update and Send but­
tons are only active on online mode otherwise dimmed). Refer to Help (press F1 key) for further de­
tails of the available settings.
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5.3 Dispatching a voice message

In the event of a fault, the store computer can dispatch a pre-recorded voice message to a previously specified
telephone number, transmitting this voice message, for example, to the service centre.

A serial modem with speech capability is required for the recording of the voice message.

The voice message can be recorded via the menu item Store/Voice Modem and saved to the CI 3000 store
computer.

The following steps are necessary:

1. Select the voice modem connection (the computer connection must be made via modem, see chap. 4.2.1).

2. Record the message (only possible offline) and if required play back to check.

3. Send the voice message to the store computer (only possible online).

For further details of the separate functions refer to LDSWin Help (F1 key).

5.4 Configuring devices

LDSWin automatically detects the devices/components installed in the store while exchanging data with the
store after successfully dialing up an online connection. Alternatively the devices can be added to the device
lists and set up there. These lists can be opened for refrigeration points by choosing Select Channel from the
Refrigeration Points menu, for pack controllers by choosing Select System from the Refrigeration Systems
menu and for wireless sensors by choosing Select Wireless sensors from the Receiver Modules menu.
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5.5 Adjusting the store layout

After the pack controllers, refrigeration points and receiver modules for radio sensors have been configured,
these appear in the store layout in the store view. The size and shape of all of a store's display elements can be
changed, the elements rearranged and repositioned, and if desired, adjusted to reflect the real arrangement of
devices in the store. Shape of the elements can also be changed. To do so, activate Change Mode in the View
menu.

To change size of a display element:

� Click on the display element once with the left hand mouse button. There appear a rectangle which signalled
the selection (see arrow).

� Click on the display element with the left hand mouse button and keeping the mouse button pressed change the size.

To change position of an element:

� Click the icon once and, holding down the left mouse button, drag it to the position wanted.

� Alternatively, after selecting an element it can be moved to a new position by UP/DOWN and LEFT/RIGHT keys on
the keyboard.

Multiple selection: Select the desired display elements with the left hand mouse button while hold­
ing down the SHIFT key, or draw a rectangle with the left hand mouse button while holding down the
SHIFT key, see also the online help (F1 key).
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To change shape of an element (only applies to refrigeration components):

� Click on a free part of the image background so that the sizing handles are no longer visible.

� Right-click the icon to change its shape.

� Right-click repeatedly to successively view the shapes available and select the shape wanted.

Individual background and images

� A background image (floor plan/process diagram) can be saved for the store layout:

- Classical market: Choose Background Image from the Store / Background menu item.

- BMS Store: Right-click the store layout and chose Load Image from the shortcut menu.

� Under the menu item Store - Image selection for components, individual images/photographs for each case or
room, i.e. each component, can be saved for display in Easy Mode.

Multiple page view of a store

In order to provide a clearer overview of larger, more complex stores it is recommended that they are displayed
in the so called multiple page view, see menu item View / Multiple Page View Current Store. This form of visuali­
sation can be deployed, for example, when a graphic separation between NT and LT is desired:

Detailed information on the creation of individual pages is provided in chapter 12.4 onwards.
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5.6 Store Archiving

After a store has been completely adjusted and configured this can be archived, i.e. saved via the menu item
Store/Archiving :

Before a firmware update or a replacement of the CI 3000 Store Computer (see this documenta­
tion), a complete archiving of the Store Computer's configuration should be conducted! The com­
plete archiving of all of the store's controller data, depending on the number of components, can
take some considerable time.

Following a firmware or a replacement of the CI 3000 Store Computer the
- configuration and 
- in the following the EU archives can be sent back to the CI 3000 Store Computer.
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6 Transmitting alarms in LDSWin

All Priority 1 and 2 alarms received are transmitted by text messaging (SMS, E-Mail or FAX) according to the
configuration made. Transmission takes place via the same modem as reception of fault reports.

6.1 Required settings

To enable alarm transmission first make the following settings in the File / Settings menu:

1. General tab (see also Section 4.2.1 - General Tab)

� Service Center phone number

� Phone extension

� External dial number (PBX extensions only)

� Country

Alarm transmission by SMS and FAX is only possible with a computer link via modem.

When using a modem connected to a PBX telephone system, it may be necessary to deactivate the
”Wait For Dial Tone” option in the modem settings.
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1. Fault Reports tab

The check mark must be activated at Alarm Transmission on the Fault Reports tab to enable the alarm trans­
mission function:

The Alarm Transmission tab is only visible and can only be opened for configuration when the alarm
transmission function is activated (see Section 6.2 - Configuring Alarm Destinations).
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6.2 Configuring alarm destinations

Alarms can be routed to three destinations for SMS, E-Mail or FAX with the alarm transmission function. Each
destination can be activated separately by placing the check mark in the checkbox. The following data must be
entered for alarms to be transmitted to any destination:

Configuration of the alarm forwarding

Dest. 1..Dest. 3: Alarm destinations 1 to 3 are activated by check mark.

Alternative Dest. 1..3: An alternative destination under a different number and/or different provider can be
specified for each destination. The alternative destination will be notified if the 
message cannot be properly delivered to the standard destination.

Name: Name of service technician or mobile phone owner (optional).

Telephone number: Telephone number to which alarm is to be delivered.

Provider: Recipient's telephone provider (in Germany, e.g. D1, D2, EPlus)

Settings (SMS only)

A check mark can be used to select whether Prio 1 Alarm and/or Prio 2 Alarm is transmitted. The maximum
number of repeat attempts acts separately on each destination or alternative destination. On reaching this maxi­
mum number of attempts for a destination, alarm transmission is interrupted until the next alarm is received.

An alternative destination under a different telephone number and different provider should be set for each
destination.

No assurance is given that a message successfully transmitted to the provider will reach the intended re­
cipient within the desired time or at all in fact. Therefore, never use alarm transmission by SMS alone and
always provide for a second, separate alarm transmission route.
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Notice:
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7 Fault Reports for All Stores in LDSWin

Fault report reception can be configured for monitoring of stores and centralized reception of alarms. The appro­
priate LDSWin Host Computer must be configured at the alarm designation on the respective Store Computer.
The following alarm priorities can be assigned:

0 = Not transmitted: Fault reports are not transmitted to the Service Center or Operator PC

1 = Transmitted to Alarm Center, Service Center or Operator PC

2 = Transmitted to Alarm Center, Service Center or Operator PC

Response to alarms of Priority 1 and 2 can be configured on the CI 3000 Store Computer by choosing the Store
menu, then Properties and then the Alarm Structure tab.

Refer to the CI 3000 Store Computer documentation for detailed information.

7.1 Alarm window

Occurrence of a fault causes an Alarm window to open and a beep to be sounded. The window shows the last
fault report received with the name of the store, the refrigeration point affected and the message text. The Alarm
window closes automatically after the waiting time defined under Settings expires.

All fault reports received can be viewed by opening the Fault Report screen. To do so, choose Fault Reports All
Stores from the File menu. On opening, the window initially shows the new reports for all stores.

Clicking the Fault Reports One Store button (see Section 4.3.1 - Buttons in Store Layout) causes the
fault reports to be displayed only for the currently open store.
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Fault report receive and send time stamps can be toggled between SC Time (Store Computer time) and PC
Time at which the alarm was received by clicking the select button. A send time stamp is entered in the Alarm
End column and displayed after the fault report is sent.

Select the option buttons to alternate between new and previously acknowledged fault reports. If several reports
are in the queue, it may be helpful to sort them by other criteria. Select the appropriate Sort Criterion. Fault re­
ports can be displayed selectively by the Filter option. Fault reports can be displayed exclusively for one speci­
fied store by the Store option.

Filtering conditions can be defined across all columns by the User option. For this purpose an entry field opens
for each column above the table to allow the user to enter the filter criteria required. Wildcards '*' and '?' are also
usable as filter criteria. The asterisk (*) represents any number of characters. For example, 'tegu*' will display
entries whose first four characters are 'tegu'. The question mark (?) represents any single character at the posi­
tion where it is entered.

In the right lower corner of the window a second table is shown with the columns Store Name and No. Fault Re­
ports (visible only in the Fault Report All Stores screen). Clicking on a store in this table activates the filter crite­
rion for that store and only the corresponding fault reports are displayed.

Three command buttons are placed in the lower left of the window:

� Delete Reports or Acknowledge Reports

� Print Reports

� Close

Fault reports can be moved from the New Fault Reports table to the Processed Reports file by clicking the Ac­
knowledge Reports button. Reports must be selected in the table before they can be deleted or acknowledged.
Click on the line with the mouse to select a report.

Multiple selections can be made by pressing the CTRL key and all reports can be selected by the key combina­
tion CTRL-A. A safety prompt appears on clicking the Delete Reports button. Confirming delete causes the se­
lected fault reports to be deleted from the table file. Click the Print Reports button to print a list of either all re­
ports shown or the selected reports.

7.2 Host Computer attendance status

Fault reports received at the Host Computer can only be processed directly when a user is in attendance to re­
spond to them. The system therefore needs to be notified when the Host Computer is unattended. If this notifi­
cation is not made, the program will automatically switch to Dispatcher Unattended mode after a set time has
passed.

Action in response to the attendance status can be configured on the Alarm Structure tab by choosing Proper­
ties from the Store menu.

The telephone number filed on the CI 3000 Store Computer must be identical with that filed in
LDSWin in order for fault reports to be correctly allocated to the respective store.

The attendance status has no effect when the program is run in Operator PC mode. Refer to the CI
3000 Store Computer documentation for detailed information.
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7.2.1 Vacating the PC

Click the Dispatcher Attended / Unattended button on the toolbar in the main window or activate the check mark
preceding Dispatcher under File / Settings / General tab. This displays a message box containing a prompt to
the effect that the Dispatcher status will be changed. Click Yes to confirm the change.

7.2.2 Showing attendance status

The current status, Dispatcher Attended or Dispatcher Unattended, is shown on the status bar at the bottom left
of the program window.

7.2.3 Restoring attended status

� Again click the Dispatcher Attended / Unattended button.

� Confirm Yes in response to the prompt.

The status bar then shows Dispatcher Attended.

7.2.4 Time control

If no user activity takes place while the program is in Dispatcher Attended mode, it will automatically change to
Dispatcher Unattended mode after a set period of time. Before doing so, an alert is displayed, accompanied by
a warning beep.

Extended cross-store analytical functions for fault reports are available in the Premium Version of
LDSWin (see Section 1 - LDSWin System Design).
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7.3 Store Computer check

The Store Computer Check function can be used for periodical checking of communication between the CI�3000
Store Computer and monitoring computer. This will ensure that alarms generated in the store are indeed re­
ported to the monitoring computer.

Store Computer Check is essential to ensure proper monitoring of the communication link and
should always be activated when reliable remote alarming is required.

Five times can be set for Store Computer check to be performed (open the File menu and choose Settings, then
Store Computer Check). Each of these times can be activated or deactivated separately:

Store Computer Check must additionally be enabled for the respective store. The required settings are
as follows:
1. Activate the check mark before SC Check in the Store menu under New / Folder / Change Name/
   Telephone button and in the File menu under Settings. 

2. Activate the check mark before SC Check in the File menu under Settings / General tab 
   (see also Section 8.1 - Creating a Store)

Store Computer Check proceeds as follows:

� The program dials up the store to be checked.

� If a successful answer is received from the store, the next store is checked.

� If a check is not successful, it is repeated after completing check of all the stores covered.

� LDSWin generates an alarm if check is still unsuccessful after the third attempt.

To ensure proper Store Computer check, the check mark must not be activated before Direct Con­
nection in the File / Settings menu (see screen in Section 4.2.1 - General Tab).
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8 Forms in LDSWin

A form defines the data that is to be evaluated and the chart that is to be used for graphic data presentation.
Forms are also used for editing scripts. They can be used to define the scope of archived data to be transmitted
by a script. LDSWin contains a number of predefined forms. The available forms are listed in the Form Manager
window (File / Form Definition menu).

User Priority 1 is required to change or create forms! LDSWin contains a number of predefined
forms, which cannot be deleted by the user. However they can be copied and then modified by the
user, (see chapter 8.2 ).

The Types of form are as follows:

- Forms to display controller data

These forms determine the content and appearance of tables and charts for the devices. These forms have a
function corresponding to small programs that perform specific evaluation of data.

- Forms to execute automatic jobs

These jobs concern specific evaluation of store data. Examples are the temperature list or 24-hour temperature
list, which simplifies recording for compliance with HACCP (see Section 6 - Scripts in LDSWin). These forms
can not be edited.

Further information on special forms is available under Help (F1 key).
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8.1 Allocating forms to devices

Forms are allocated in the device lists:

� Choose Select Channel from the Refrigeration Points menu to open the device list for case/coldroom controllers.

� Choose Select System from the Refrigeration System menu to open the device list for pack controllers.

The further procedure is identical for both refrigeration points and pack controllers:

� In the device list, select the channel for the device you want. Use the scroll bar to scroll through the table as
necessary. The currently set form for the device is shown in the Form column.

� To change the form, click on the Form field to open a list of available forms.

� Select the form you want from the list.

� Close the device list by clicking the Apply button. The new form defines the chart or table for the device.

Refer to Help (F1 key) for additional information.
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8.2 Editing forms

All forms are saved in Form Manager, where they can be copied, created and/or changed. To open Form Man­
ager, choose Form Definition... from the File menu. This opens the Form Manager window. The command but­
tons can be used to perform the following actions:

- Create new forms

- Edit existing forms

- Copy existing forms

- Delete forms

8.3 Creating a new form

� Click the New button to open the Form Definition window, in which all details relating to function and appear­
ance of the form can be entered.

� Type a name for the form in the Name field.

� Select the number of channels you want for each axis.

The program does not allow duplication of form names. If an existing name is entered for a new
form, the user will be prompted to change the name. The Form Definition window cannot be closed
before a valid form name has been assigned.

8.4 Copying a form

� In Form Manager, select the form that is to be copied from the list.

� Click the Copy button and type in a new name for the copy.

The program does not allow duplication of form names. If an existing name is entered for a new
form, the user will be prompted to change the name. The Form Definition window cannot be closed
before a valid form name has been assigned.

The new form will then be displayed in the Form Manager list.

8.5 Deleting a form

� In Form Manager, select the form to be deleted from the list.

� Click the Delete button.
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8.6 Modifying a form

� n Form Manager, select the form to be modified from the list.

� Click the Edit button.

� The form can then be changed as required in the window that opens.

Refer to Help (press F1 key) for details of the settings that can be made.
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9 Scripts in LDSWin

Using scripts, data can be archived automatically at regular intervals (e.g. for production of temperature lists). A
script is a set of instructions for automatically interrogating defined measurements at a store. A sequence of
forms can be defined in a script. After successfully running a script, the next run time is scheduled and entered
in the script description.

If a script cannot be run successfully three times in succession, the next run time is recalculated and
a corresponding fault report is generated.

9.1 Script management

To open the Script Manager selection window, choose Script Manager  from the File menu. All scripts are filed
under Script Manager, where new scripts can be created and existing scripts copied and/or modified.

Scripts can be created for separate stores on the Host Computer. Script run must also be activated
by choosing the File menu, then Settings and then the General tab!

The list of scripts shows the script name together with the store name, the next run time, the run interval and the
script status. Run status of scripts can be activated or deactivated by clicking in the Status column.

Owing to the amount of data involved when monitoring several stores, use of time-controlled scripts
on the Host Computer is only recommended for selective tasks, e.g. monitoring a specific store and
selected refrigeration points or pack controllers.
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9.2 Editing scripts

Click the Edit button to commence editing scripts. This enables forms to be selected to be run within the script
and options can be specified for each form to either print data in table or chart form or save it to file.

The following parameters can be defined by the user for each script:

Script Name:

The program differentiates scripts by their name. A unique name must be assigned to each script.

Store:

One of the stores created or existing in the program must be selected as this parameter. The various script func­
tions are executed when the script runs.

Next Run (Date/Time):

This parameter defines the time of the next script run. Setting the parameter completely to zero deactivates the
script. After a script has run, this parameter is automatically increased by the value set for the run interval.

Run Interval (Days, Hours, Minutes):

After a script has run, the Next Run parameter is automatically recalculated according to the run interval and
changed

Forms To Run:

The user can select the forms to be used in the script. Data contained in the actual value channels used in the
forms is interrogated and saved when the script runs.

Tip: In order to obtain the latest graphic data from all available controllers of a store, the form 
Controller archiving should be selected. All archive data required for the graphic analysis is re­
quested (see also chapter 5.1 Allocation of forms to devices). The energy data of the store is also
requested, in as far as this is configured.
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Print:

Print options can be defined separately for each form. Clicking in the Chart or Table column of the Print para­
meter defines data printout in chart or table form respectively.

Also Save As.. / E-mail To.. :

The data transmitted is automatically entered in the databases assigned to the devices. Additionally, the data
can be saved as a chart or table or sent by e-mail. To do so, click in the appropriate column to activate data sav­
ing and enter a file name or e-mail address.

File Folder/Address button:

The file folder and file can be selected from a Folder dialog or an e-mail address can be defined.

Sending data by e-mail requires the sender's address and the SMTP server to be entered under File
/ Settings / Communication Tab E-Mail.

It is possible to choose special  forms which have special functions when used in scripts. For exam­
ple by executing a Script with the form 24 h Temperaturliste a temperature list for one day with all
the regulators is created. Refer to Help (F1 key) for additional information about the existing special
forms.

Example: This 24-hour temperature list was saved as a PDF file and printed by a script:
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Notice:
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10 Store analysis in LDSWin

In LDSWin there are a range of special functions for the quick and concise analysis and display of selected
data, i.e. operating states of LDS components within a store.

10.1 24 h channel list

By means of the 24 h channel list, selected analog value channels can be displayed as hourly averages over a
24 hour period. The list includes all case controllers made available by the selected analog channel (see Chan­
nel selection: opening degree/heating degree/superheat):

In order to keep the 24 channel list up to date, a script with the special form ”24 h Channel list”
should be created and run cyclically (see chapter  9.2 Editing scripts).
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10.2 Status overview

By means of the status overview, selected status channels can be displayed over a defined time period. The list
includes all case controllers made available by the selected channel (see Channel selection):

In order to keep the status overview up to date, a script with the special form “status overview”
should be created and run cyclically (see chapter 9.2 Editing scripts).
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10.3 Consumption log

By means of the consumption log, the user can obtain an overview of the store's energy consumption. The list
includes the selected meter types

In order to keep the Consumption log up to date, a script with the special form “Consumption log”
should be created and run cyclically (see chapter 9.2 Editing scripts).

The store's energy consumption can be displayed both as table and as graphic (see picture), by clicking on the
corresponding button:
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Notice:
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11 Communication Via TTY Port

LDSWin can communicate via the TTY port with 
- the UA 300 case/coldroom controller (parameter setting and EU Archive readout) and 
- the VS 300 compact pack controller (parameter setting only).
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11.1 Requirements

The following requirements and preparations are needed to facilitate communication:

1. TTY adapter with 9V DC power supply

Before connecting to the UA 300/VS300 to a PC or notebook computer, check that 
- the power supply is set to 9V DC and 
- the connecting jack of the 9V DC power supply has the correct polarity as shown in the illustration 
  above!

2. PC or notebook computer with serial RS232 port (COM-Port)

3. LDSWin PC Software
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11.2 Reading out EU Archives from case/coldroom controller

The procedure for reading EU Archives from the UA 300 case/coldroom controller into the LDSWin PC Software
is described below:

1. Connect power supply to TTY cable (see notes in section 1.1!).

2. Connect TTY cable to the UA 300 (see folowing figures) and to the serial (COM) port of the PC or notebook:

UA 300 x yC for cap rail mounting with connected TTY cable

UA 300 x yS for panel mounting with connected TTY cable

3 Start the PC or notebook.

4. Start the LDSWin PC Software.
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5. In the File / Settings menu, set computer link on the General tab to Operator PC (TTY) and set direct con-
nection to the COM port being used:

6. Choose Select Channel from the Refrigeration Points menu to open the Select Channel screen. Select 
the controller wanted from the list displayed by right-clicking with the mouse. This opens the following 
shortcut menu:

The CAN bus station wanted must first be entered manually when a new store has been created.
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7. Choose the CAN Station xx: EU Archive shortcut menu to open the UA Direct Connection screen:

8. After entering the starting date for EU Archive readout and the number of days for which data is to be 
read out, click the Request button to confirm. Current status of readout is shown in the screen window 
and on the progress bar. The screen can be closed after the EU Archive has been read out from the case/
coldroom controller.

9. Data read out from the EU Archive can be displayed in chart or table form in the LDSWin PC Software.

11.3 Parameter setting via TTY port

Parameter setting can be made on the UA 300 case/coldroom controller of Version 2.31 and higher and the VS
300 compact pack controller via the TTY port.

11.4 Parameter setting on UA 300 case/coldroom controller

The procedure is as described in section 11.2, steps 1-5:
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Right-clicking on the UA 300 case/coldroom controller wanted opens a shortcut menu. The required screen can
be opened by the command

- CAN Station xxx: Controller Data (Entry screen for controller data) or

- CAN Station xxx: Setpoints (Entry screen for setpoints),

(See also section 4.6 - Defining Setpoints for Refrigeration Points and Pack Controllers).

11.5 Parameter setting on VS 300 compact pack controller

Proceed as described in section 11.2, steps 1-5. Connect the TTY adapter to the VS 300 compact pack con­
troller as shown in the following illustration:

Then make parameter settings in LDSWin as follows: Choose Select System from Refrigeration Systems menu
to open the Select System screen:

Right-clicking on the VS 300 pack controller wanted opens a shortcut menu. The required screen can be
opened by the command

- CAN Station xxx: Controller Data (Entry screen for controller data) or

- CAN Station xxx: Setpoints (Entry screen for setpoints),

(See also section 4.6 - Defining Setpoints for Refrigeration Points and Pack Controllers).
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Notice:
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12 BMS Interfaces and Store Views in LDSWin

Using intuitive visualisations, LDSWin makes complex store contents with integrated building control technology
comprehensible. Maintenance group-related process visualisations provide e.g. the store director or facility man­
ager with a quick overview of the current status of the refrigeration technology (NT/LT), the ventilation technol­
ogy or heating circuits. This enables faults to be quickly identified, analysed and rectified. The visualisations can
be individually tailored to the local conditions.

Quick overview of maintenance groups

Through the continuous comparison of all operating values, temperatures, operating times, energy consumption,
error messages and much more, are saved to the hard disc. LDSWin automatically records a wide range of sta­
tistical performance indicators, on the basis of which a system can be assessed, optimised or maintenance work
planned in good time. All the data is displayed in the form of clearly arranged diagrams. In the case of BMS
stores, individual maintenance groups (e.g. cooling, heating, ventilation, water heating, etc.) are accessed via
individual pages:

Process visualisation under LDSWin - using the example of the central ventilation equipment.

In the example the individual pages are indicated by the following abbreviations:

Store overview: Classical view - display of the entire refrigeration technology (always available)
GLT (BMS) Building services management system
ZLG (CVE): Central ventilation equipment
ÜDA (OS): Overpressure system
UML (ACS): Air circulation system
WW (WH): Water heating

Access to the individual maintenance group pages in the store view is controlled by the store-spe­
cific password which is requested when a BMS store is opened (see chapter 12.2).
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12.1 Creating a BMS store

The creation of a BMS store in LDSWin is carried out via the store selection screen using the normal procedure
(see chapter 5.1). In order for a BMS store to be recognised within LDSWin as a BMS store, there must be at
least one SPS, see menu item Store/Characteristics:

If the number of SPSs = 0, then the store is displayed in the previous form, no BMS functions are
available for the market.

If the number of SPSs is raised above 0 then the store view is automatically switched to BMS operation. Here a
page with the title ”Store Overview” is always displayed, which plays a special role for the maintenance groups.
This special role will be discussed in detail in chapter 12.1.1.

If the number of SPSs is changed, then the store layout is automatically regenerated. Any changes
to the store layout which have not been saved will be lost!

12.1.1 Special role of the ”Store Overview” page:

This page is always created by LDSWin and cannot be deleted, only its name can be changed. It displays all the
elements of the ”classical” store view such as refrigeration points, pack controllers, radio sensors, alarm inputs
or universal boxes.

Owners of standard dongles can always access this page, even if they don't possess an explicit access pass­
word for the BMS store. This provides them with access to the refrigeration technology components in the event
of servicing (see chapter 4.3).

The page ”Store Overview” should only be released for refrigeration service users.
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12.2 Dongle variants and their functions

In addition to the conditions required for the configuration of a BMS store described in chapter 12.1, a special
dongle with BMS configuration rights is also required. Access to the software functions is administered via the
dongle.

The following dongle variants are available:

� Standard dongle, e.g. for refrigeration technicians, store operators

Access to refrigeration components (refrigeration points, refrigeration systems, radio sensors) is permitted. 
BMS pages cannot be edited and are only visible if they have been released by the project manager (see chap­
ter 12.5.7).

� BMS user dongle for e.g. store operators, heating engineers, climate control technicians:

Access to refrigeration components (refrigeration points, refrigeration systems, radio sensors) is not permitted.
BMS pages and refrigeration components in the store overview cannot be edited and are only visible if they
have been released by the project manager (see chapter 12.5.7).

Store-specific passwords (defined by the project manager) specify which pages are released for certain user
groups and which are not (see chapter 12.5.7).

As a general rule: If a password is not used during the opening of a BMS store, then

- for users of a standard dongle only the page ”Store Overview” is displayed and
- for users of a BMS user dongle no pages are displayed.

The basic distribution of rights for changing BMS setpoints (dongle with and without setpoint adjust­
ment) is carried out along the same lines as the existing procedure (see chapter 3.2). The dongle
and the LDSWin access password determine whether users are restricted to viewing setpoints (user
priority 0) or whether they can also send changed setpoints to the store (user priority 1). 
The password can be entered by the respective user at a later date under the menu item Store /
Store Password.

� BMS configuration dongle for e.g. persons in charge of configuring the building management system:

Full access and configuration rights for all maintenance groups, including all refrigeration components. Via
store-specific passwords he specifies which pages are released for certain user groups and which are not (see
chapter 12.5.7). The BMS dongle opens stores without the need for a password.
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12.3 BMS channels

The process images which can be displayed in BMS stores are generated using so called BMS channels in
which all the values required for the display of the process (actual values, setpoints, alarm statuses) are saved.
The BMS channels should be defined before configuration, so that these channels can be accessed when cre­
ating the desired pages. These channels are loaded into the project using the file glt.cfg under the menu item
BMS/Configuration:

Ideally, the glt.cfg file is provided by the person in charge of configuring the BMS. The corresponding
assignments are contained in the BMS channel documentation.

The screen ”BMS Channel Configuration” following the loading, i.e. addition of the BMS channels:

For the complete commissioning of the BMS store, the ”BMS Channel Configuration” must first be
saved to the store computer using the Send button. Subsequently, every time a store is accessed
the ”BMS Channel Configuration” is automatically loaded. If required, the ”BMS Channel Configura­
tion” can also be accessed via the Update button.
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12.4 Creation of pages for different maintenance groups in one store

In the main window, different pages for the display of individual maintenance groups can be created. In order to
do this, the right hand mouse button must be clicked in the tab area of the store view. A pop-up menu ”New
Page” opens, so that a new page can be created and named as required:

When creating a page it is useful to know what it is to be called, i.e. which maintenance group will be
displayed and which BMS channel (see chapter 12.3) can be accessed from this page as access
rights to the maintenance groups are determined by access to the individual pages.

Clicking with the right hand mouse button at the side of the page opens the context menu for this page:  70

Using the context menu one can, amongst other things, rename the page, delete it or load a background picture,
i.e. a floor plan or process image, for better visualisation. Furthermore, screens for the insertion of display ele­
ments such as interface texts can be called up. Detailed information on this theme is provided in chapter 12.5.
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12.5 Creation and configuration of display elements

For each page, individual optical display elements can be created. Clicking with the right hand mouse button at
the side of a page opens the context menu for this page: Here the desired display elements can be called up
and edited. The following display elements are available:

- Channel display see chapter 12.5.1 (Function only available in BMS store)
- Edit Page Button see chapter 12.5.2
- Edit Graphic Button see chapter 12.5.3
- Edit LDS Object see chapter 12.5.4
- Edit Interface Text see chapter 12.5.5
- Edit Group Control see chapter  (Function only available in BMS store)
- Edit Image Element see chapter 12.5.6

For all display elements the respective context menu with the configuration options is opened by clicking with
the right hand mouse button.

If the change mode is activated in LDSWin by means of a check mark (Menu View/Change Mode),
the display element on the page can be shifted or its size or position changed as required (see also
chapter 5.5). The page context menu is then no longer available.

Praxis TIP: If a page (including all the display elements, background picture, i.e. process image etc.) is required
in other, very similar projects, then the page can be exported using the command ”Export Pages” in the context
menu. The command ”Import Pages” is available for importing pages. The import and export functions are only
available in the BMS store.

In order to improve the identification of display elements during the configuration phase, it is recommended to
use the so called BMS draft mode (see menu item BMS), as this option provides the display elements with a
frame for easier identification.
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12.5.1 Channel display (BMS channels)

With the help of the channel display, individual BMS channels, separated according to maintenance groups, can
be displayed on the page. In order to do this, click with the right hand mouse button at the side of the page and
select ”Channel Display” from the context menu. The following screen opens:

The following columns can be edited as required:

Indicator: With this text, the display element on the page can be named and 
displayed as required, at variance to the text from the SPS.

Unit: With this text the display element units are indicated.

The unit is a channel characteristic!
The same channels will be displayed with the same unit text on all pages.

Display: Select using a check mark whether a channel is to be displayed on the page or not.
Type: Here one can set the channel type for the display element.

The channel type is configured under the BMS channel characteristics (see chapter 12.3).

At present the following display types for the respective channel types are available:
Analogue setpoint: Setpoint of an anaologue value
Analogue actual value: Actual value of an analogue value
Digital setpoint: Switching command on/off
Digital actual value: Status image (with the option of loading any desired graphics 

for indicating the status), LED red, LED green, LED yellow; 
LED green-red, LED blue, LED white
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12.5.2 Page buttons

With the page buttons it is possible to spring to other pages, comfortably opening other pages without having to
press the tabsheets:

In order to do this, click with the right hand mouse button at the side of the page and select ”Edit Page Buttons”
from the context menu. In the column ”Indicator” enter the text to be displayed in the page button (e.g. ”Back to
Store View”). In the column ”Spring Page” select the target page.

When creating page buttons the configuration of users and access rights should be considered as
not all the pages of a project (and consequently the page buttons) can be operated by all users, see
chapter 12.2.

12.5.3 Graphic buttons for displaying forms

With graphic buttons, forms, e.g. performance measurement, current consumption etc. can be called up as re­
quired (for more information on forms see chapter 8).

In order to do this, click with the right hand mouse button at the side of the page and select ”Edit Graphic But­
tons” from the context menu. In the column ”Indicator” enter the text to be displayed in the graphic button (e.g.
”Performance Measurement”). In the column ”Form”, the desired form is selected.

12.5.4 LDS objects for the display of LDS components

With the button for inserting LDS objects, the LDS components can be displayed on the page as required. This
is of special use when e.g. a graphic separation between NT and LT components is desired. Exactly the same
display elements are available as those displayed on the ”Store View” page (see chapter 12.1.1).

In order to do this, click with the right hand mouse button at the side of the page and select ”Edit LDS Objects”
from the context menu.

At the top of the screen it is possible to select from ”refrigeration points, pack controllers and alarm inputs”. In
the right hand column ”Display”, a check mark is used to select whether and which LDS components are to be
displayed on the page and which not.
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12.5.5 Interface text

With the button for inserting interface text, text can be positioned on the page as required, e.g. in order to com­
ment on a maintenance group or to provide more information on background graphics.
In order to do this, click with the right hand mouse button at the side of the page and select ”Edit Interface Text”
from the context menu. 
The desired text is entered in the ”Indicator” column of the new screen. After entering and confirming, the inter­
face text appears at the top left hand side of the page. In order to change the displayed text, click on the inter­
face text with the right hand mouse button.

Text up to a length of 80 characters can be entered.

12.5.6 Image elements

With the button for inserting image elements, graphics can be positioned on the page as required, e.g. in order
to display a maintenance group in greater visual detail, to integrate a photo, for example of the water heating
equipment, or to insert other graphics to enhance the process mapping:

In order to do this, click with the right hand mouse button at the side of the page and select ”Edit Image Ele­
ment” from the context menu.

The image element must be identified in the new screen. The image element appears at the top left hand side of
the page. To load graphics it is necessary to switch to the change mode and click on the image element with the
right hand mouse button.

12.5.7 Configuration of users and access rights

The configuration of user groups and their access rights must be carried out by the project manager (this re­
quires a BMS configuration dongle) under the menu item BMS/Configure BMS User.

The configuration of users, passwords and access rights should be carried out after the BMS store
has been completely configured as all the pages will have been defined and can then be allocated to
individual users on a systematic basis.
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Notice:
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13 Premium Version Functions

In the premium version of LDSWin a range of extended cross-store analysis functions is available. These func­
tions require a special software licence.

- Grouping of fault reports see section 13.1

- On time analysis see section 13.2

- Consumption analysis (energy/water/gas) see section 13.3

The premium functions are accessed via the File menu:
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13.1 Grouping fault reports

Choosing Group Fault Reports from the File menu shows statistical evaluation of fault reports for stores:

The chart can be saved in *.BMP or *.JPG format by clicking the Save button.

Fault reports are grouped in the separate columns. Grouping is made by fault report number.

In order to ensure that fault reports are kept up to date for the stores to be evaluated, a script should
be created for these stores with the ”Alarm List” form and run periodically (see section 6.2 - Editing
Scripts).
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13.2 On time analysis

Choosing On Time Analysis from the File menu shows statistical evaluation of on time for stores. Analysis is
made of the percentage daily cooling on time of refrigeration points and the utilization of pack controllers:

The chart can be saved in *.BMP or *.JPG format by clicking the Save button.

Refrigeration point on time

A very high on time for refrigeration points (e.g. over 95%), may be an indication that the refrigeration points
hardly attain their cooling target temperatures. Possible causes are:

- Exceptionally high ambient temperature

- Incorrect stocking of display cases

- Severe icing of evaporator / failure of evaporator fans

- Continuously open door on coldrooms

- Incorrect settings or low refrigerant level on the respective pack controller

Pack controller on time

A very high on time for pack controllers may be due to the following causes:

- Exceptionally high outdoor temperature or store temperature

- Low refrigerant level or incorrect settings on pack controller

- Oversized refrigeration compressor pack
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13.3 Consumption analysis

Choosing Consumption Analysis from the File menu opens the screen for statistical evaluation of energy/water/
gas consumption at different stores.

The chart can be saved in *.BMP or *.JPG format by clicking the Save button.
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14 Order numbers and accessories of LDSWin

14.1 LDSWin PC software

Type Description Order number

PC software 
incl. USB dongle

- Incl. modem 56  KI, with setpoint regulation

- Incl. modem 56  KI, without setpoint regulation

- Incl. modem 56  KI, with setpoint regulation,
  premium functions for statistical evaluation

- Incl. CAN bus-PC Adapter, with setpoint regulation

- Incl. CAN bus-PC Adapter, without setpoint regulation

- 2nd license, with setpoint regulation

- 2nd license, without setpoint regulation

LDSWINM003

LDSWINM004

LDSWINM007

LDSWINA001

LDSWINA002

LDSWIN2001

LDSWIN2002

14.2 Components for LDSWin

Component Description Order number

Null modem cable Connects the flash cable with
the serial interface of the PC / notebook, lenght: 3,0 m

PCZKABSER2

Null modem cable
extension

Extension for null modem cable, 
Lenght: 1,8 m

PCZKABSER3

Adapter
PCMCIA / COM

Adapter PCMCIA / COM (1 x seriell) PCZPCMCIA1

Modem 56 KI Modem 56 KI - Analog PCZMODEM02

Modem ISDN Modem ISDN / Analog Hybrid PCZMODEM03

CAN bus-PC Adapter For integration of user PC or service PC in the LDS System LICANBUSAD

CAN bus-Y-cable CAN bus-Y-cable for PC to CAN bus connection LICANYKAB

TTY-
Interface converter

Interface converter from PC to UA 300 / VS 300 EAGTTYR232

LAN Gateway Network connection (LAN) for User / service PCs 
(e.g. store manager/remote PC) in the LDS-System

KGLLDSGW02
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